
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

  

Version Date Illustrated articles 
11.0.11155 July 17th 2025  

11.0.11118 June 10th 2025 What’s new in 11.0 

   

Release Notes 

Digital Surf Software Updates     Digital Surf FAQ 
www.digitalsurf.com/support/software-updates  www.digitalsurf.com/support/faq
  
Digital Surf Support solutions     Support Center 
www.digitalsurf.com/support/support-solutions  support.digitalsurf.com 

https://www.digitalsurf.com/news/whats-new-in-version-11/
http://www.digitalsurf.com/support/software-updates/
http://www.digitalsurf.com/support/faq
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What’s new 
 

 Homogenization of spectral studies 
Normalized display in spectral 
studies 

A normalized display is now available on most studies on Hyperspectral 
image and Spectrum curve studiables. The [Normalize] button has been 
added to the "Spectrum curve view ", Strips view" and Stacked view" studies. 

Cursor on spectrum axis in 
"Spectrum curve view" study 
 

A movable cursor is now displayed in the "Spectrum curve view" study. It is 
possible to display the corresponding abscissa (W) and ordinates (Z) of the 
current spectrum in the study’s results table (by selecting them from the 

Information tab of the Select parameter dialog). 
Simplified Spectrum curve 
parameter 

The Spectrum curve parameter now only displays the current curve element 
number. (Coordinates in pixel have been removed). This concerns all studies 

on hyperspectral image (except 3D). 
Statistics parameters removed in 
spectral studies 

The statistical parameters have been removed from the Spectrum curve view 
study and the Peak fitting study. An information message informs the user when 

loading documents created in previous versions of the software. It is still possible to 

create statistics studies from series of results, coming from Spectrum curve view study 
or Peak fitting study. 

Skip empty curves in spectral 
studies 

When navigating through spectra, the user can now skip the pixels with 
empty curve (non-measured points) using Ctrl+Page up/Page down shortcut. 
This concerns all studies on Hyperspectral and spectrum curve studiable. 

Shortcut to navigate between slices 
of hyperspectral images 

In the Hyperspectral image View study, the user can now navigate between 
slices (W spectral axis) using the Shift+ Page up/Page down shortcut. 

Homogenization of spectrum curve 
style interface 

The ribbon buttons for curve visualization and style, have been homogenized 
with Hyperspectral image study interface. This applies to "Spectrum Curve View" 

and "Peak Fitting" studies on Hyperspectral image and Spectrum curve studiables. 
[Analysis] group on spectral studies 
ribbon 

The [Peak fitting] button in the Studies tab on spectral studiables has been 
moved to a new [Analysis] group. 

  
 Removal of non-applicable preferences 
Removal of non-applicable 
preferences 

The Global Preferences of the software are now displayed only if applicable 
on user product. 
This concerns the following preferences: 

. The 3D preferences and the Spectral Axis Orientation in the Axis settings section. 

. The Create Multi-channel image function in the Other actions section. 

. The Types of studies in the Default studies, Exporting studiables and Default 

Smartflow sections. 
. Show Cloud point studiables in the in the Default Smartflow, Default studies, 
Exporting studiables sections. 

  
 Other general features  
Reduced calculation time in the 
“Stitch together in 3D space” 
operator 

The calculation time has been improved in the “Stitch together in 3D space” 
operator on Point cloud and Surface studiables. 

Increased cinema speed on 
Hyperspectral image 

The speed showing slices along the spectral axis (W-axis) using an 
animation has been improved on Hyperspectral image studiables. 
The rendering has been also optimized when scrolling through the slices. 
This also applies to IV spectroscopy image studiables. 

Information on obsolete 3D view on 
Multichannel Cube 

A message now suggests using the new “3D view” study on Multi-channel 
image studiables, where applicable, when reloading documents created in 
previous versions. 

Link to direct print The user can create a button or a hyperlink in the document, that directly 
prints the document without any dialog. It replicates the last-used printer 
settings. 

PDF export on command It is now possible to export the current document as a PDF using a simple 
command line (name and path is no longer required). 

July 17th 2025 

Version 11.0.11155X 
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Bug corrections (A and B type) 

 Type 

 

Bug Description 
 

MNT- 

10985 
A 

The software may crash when calculating parameters on deviations on Shell studiables 
if they contain infinite values. 

MNT- 

11463 
A 

Curves inserted in the result of the "Add/remove spectrum curves" operator on Spectrum 
curve studiables may be lost when recalling or recalculating the operator if the added 
curves are no longer available (deactivation of the operator that applies to the added 
curves). 

MNT- 

11584 
A 

The 3D view of the "Summary of the current operator" study is not updated properly in 
some cases during studiable substitution. 

MNT- 

11663 
A 

The calculation may take a long time or the software may crash when applying certain 
combinations of operations from the Alignment and Post-processing sections in the 
"Stitch together in 3D space" operator on Shell studiables. 

MNT- 

11709 
A 

The software may crash when loading old documents containing a" Summary of the 
current operator" study on Shell or Point cloud studiables. 

MNT- 

11733 
A 

The software may crash when exporting the “Summary of the current operator” study on 
Multi-channel image studiables as an image. 

MNT- 

11754 
A 

The unit is incorrect by default when first launching the software and when restoring 
factory settings in the “Extract areas” operator. Affects all studiable types. 

MNT- 

10302 
A 

Rendering colors are not preserved in the CAD compare study on Shell studiables when 
reloading a document in a particular case. 

MNT- 

11778 
A 

The software may crash when loading a document containing studies with synchronized 
cursors in a particular case. 

MNT- 

10286 
B 

The “Extract contour profile” operator on Shell studiables never generates a closed 
contour profile, and the Create circle (from closed profile) tool in the Advanced contour 
analysis study on Profile and Contour profile studiables therefore cannot be applied. 

MNT- 

11431 
B 

The color scale is not shown in the 3D view of a Thickness analysis study when loading 
documents where this was visible if they were created in previous versions of the 
software. 

MNT- 

11494 
B 

It is not possible to optimize the palette of the reconstructed tip in the 3D view Tip surface" 
of the “Tip deconvolution" operator. 

MNT- 

11524 
B 

The spacing between the contour lines is incorrect in the “3D view of the surface” study 
if the Imposed scale option in the Scale range section of the Z-axis settings is selected. 

MNT- 

11537 
B 

The display of the Curvature in the Color options in the “3D view of the shell” study on 
Shell studiables is not reapplied when reloading documents created in previous versions 
of the software. 

MNT- 

11550 
B 

The normalization mode in the X/Y-axis settings in the “3D view of the multi-channel 
image” study on Multi-channel image studiables is not recovered when reloading old 
documents. 

MNT- 

11555 
B The filling is incorrect in the "Morphological envelopes" study on Profile studiables. 

MNT- 

11560 
B 

Only the maximum amplification is visible in the 3D view of the “Thickness Analysis” 
study. 
The studiables are displayed without their actual position in the "Wear or Deposit" study. 

MNT- 

11572 
B 

The topography and intensity layers share the same palette in the "3D view of the surface 
+image studiable" study on Surface + image studiables. 

MNT- 

11573 
B 

The 3D view result disappears in the "Map local properties" operator when displaying the 
intensity layer of a Surface + image studiable. 

MNT- 

11574 
B 

It is not possible to change the Source view channel in the "Map local properties" operator 
on Surface + image studiables. 

MNT- 

11576 
B 

The order of studiables in the Available studiables list in the "Stitch together in 3D space" 
operator on Surface studiables is incorrect when recalling the operator. 
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MNT- 

11579 
B 

Undo/redo of the application of the options of the [3D shape] button in the 3D view studies 
does not work. 

MNT- 

11601 
B 

Updating from some builds in version 10 to version 11 via the Download new major 
version button in the Search for updates function in the Help tab can result in downloading 
an incomplete or unusable file. 

MNT- 

11602 
B Graduation displays are sometimes incorrect in the 3D view of studies. 

MNT- 

11613 
B 

The number of points shown in the visualization of the Resolution under the [3D shape] 
button is incorrect in the “3D view of the surface” study on Surface studiables. 

MNT- 

11614 
B 

The Optimize setting in the Resolution option in the [3D shape] button of a 3D view study 
is not applied by default when creating a studiable of higher resolution than the current 
3D preferences.  
Affects Surface, Image, Series of surfaces, Surface + image, Multi-channel image, Multi-
channel cube, Shell, Hyperspectral image, IV spectroscopy image studiables. 

MNT- 

11615 
B 

The Optimize feature from the [Resolution] button in the “3D view of the surface” study is 
not taken into account when reloading documents created in previous versions of the 
software. 

MNT- 

11639 
B 

The "3D view of the "Wear or Deposit" study on Surface studiables is displayed outside 
the frame if the option A single thickness layer is selected in the ‘Selection of analyzed 
layers’ dialog box. 

MNT- 

11646 
B 

Modifications to the Object colors and 3D print options are not taken into account in the 
preview of the Export options for the 3MF file format on Surface+image studiables. 

MNT- 

11650 
B 

The validity of tolerances is not always correctly updated in the "Table of results" study 
when a result used in the ‘Define tolerance limits’ dialog box is modified. 

MNT- 

11652 
B 

It is not possible to colorize the mesh using curvature in the "3D view of the shell" study 
on Shell studiables after applying the "Correct the shell' operator. 

MNT- 

11659 
B 

The extraction area in the "Extract areas" operator on Shell or Point cloud studiables is 
shifted when recalling the operator. 

MNT- 

11665 
B Editing a constant in the Result calculator renames the constant rather than updating it. 

MNT- 

11700 
B 

The width of the averaging area is not preserved when loading a document containing 
the "Extract profiles" operator on Surface studiables if the document was created in 
version 9. 

MNT- 

11712 
B 

The display of the Curvature in the Color options in the 3D view study on Shell studiables 
is incorrect after copying and then pasting the frame. 

MNT- 

11713 
B 

The rendering in the "3D view of the shell" study on Shell studiables is not saved when 
using the Save settings option of the [Save/apply settings] button. 

MNT- 

11732 
B 

The Z-axis settings of the 3D view of the “Wear or deposit” study are not taken into 

account and the Color scale is not modified when the Imposed scale option of the Scale 

range section is selected in the Settings for the Z-axis under the [Axis settings] button. 

MNT- 

11755 
B 

The deviations displayed in the Mesh + deviation view of the “Fit a geometric form” 
operator on Shell studiables do not always correspond to the current shape selected. 

MNT- 

11775 
B 

Applying the Deviations setting as a 3D rendering on Shell studiables is lost when saving 
and reloading the document. 

MNT- 

11803 
B 

The “Correct the baseline” operator does not properly correct all spectrum curve 
studiables when selecting the Set average selection to 0 option in the Settings section in 
a particular case. 
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What’s new 
GENERAL FEATURES FOR ALL PRODUCTS 

COPY/PASTE PART OF THE WORKFLOW 
EXPORT PDF IN BATCHES – MERGE DOCUMENTS 
NAVIGATION BOX 
EASY POSITIONING OF FRAMES IN DOCUMENT 
NEW “DOCUMENT” AND “ILLUSTRATIONS” TABS 
PRODUCT LEVEL CHOICE 
HOME SCREENS 
OTHER GENERAL FEATURES 

MULTI-TECHNOLOGY FEATURES 

MORE REALISM IN 3D RENDERING 
“3D VIEW” STUDY’S RIBBON 
X - Y CURSOR ON SURFACES AND IMAGES 
STITCHING OPERATOR 
NEW “EXTRACT LOCAL CONTOUR” OPERATOR ON SURFACE AND ON IMAGE 
CORRELATION IN “SCALE SENSITIVE FRACTAL ANALYSIS (SSFA)” STUDY ON SERIES 
CLASSIFICATION IN “FIBER ANALYSIS” STUDY 
EDGE PRESERVING FILTERS 
CUBE CUTTING PLANES 
ADAPTATION OF TOOLS TO MORE STUDIABLE TYPES 
LINKED STUDIES 

PROFILOMETRY FEATURES 

SHELL AND POINT CLOUD FEATURES 

SPECTROSCOPY FEATURES (FOR SPECTROSCOPISTS OR SPM USERS) 

NEW MOUNTAINS® PRODUCTS 

UPDATES AND TRANSLATIONS FOR INTERFACE & REFERENCE GUIDE 

 

 

 

General features for all products 
 Copy/paste part of the workflow 
Application of a part of the workflow 
on another studiable 

The user can apply a part of the document workflow (operators and studies) 
on another studiable, using Copy/Paste. The studiable can be in the same 
document or in another document. This can be considered as a temporary 
SmartFlow (with only one root studiable). 

Extraction of a part of the workflow 
in another document. 

Users can now copy a part of the document workflow, and paste it in another 
document (or in the same document). 
For example, this allows you to extract studiables, their treatment (operators) 
and analysis (studies), without upstream pre-processing, or coming from an 
overloaded document. 

June 10th 2025 

Version 11.0.11118 
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Modification of the studiable on 
which a branch of the workflow is 
applied 
 

It is now possible to modify the studiable on which a branch of the workflow 
is applied. Using drag and drop in the workflow, a branch can be moved to 
another studiable of the same document, without modifying the position of 
the studies in the document. This allows the user to rapidly visualize the 
application of the current analysis on another studiable. 

 Export PDF in batches – Merge documents 
Batch export of several documents 
to PDF, RTF, print 

It is now possible to export several Mountains® documents at once in PDF 
or RTF format. The user can choose the file names and the export folder 
location. PDF format allows sharing with any user, whereas RFT format 
allows insertion in a document editor software. 
Selected documents can also be batch printed. 

Merge of Mountains® documents It is also possible to merge several Mountains® document into a single PDF 
or RTF document. The user can choose the order of the documents to be 
merged. 

Access to the Batch export dialog The Batch export dialog is available from the Document tab, from the File 
tab, and from the contextual menu of the Mountains® File explorer panel. 

 Navigation box 
Navigation box in studies A navigation box is now temporary displayed when zooming in image views 

on studies. It shows the position of the zoomed zone in real time on the full 
zone. The zoom zone position can be modified on the fly using the mouse. 
This Navigation box is also displayed when zooming in operator previews. 
The navigation box is available for Surface, Surface + images, Multi-channel image, 
Series of surfaces, Series of images, Force volume, Hyperspectral image, 

IV spectroscopy studiables. 

 Easy positioning of frames in document 
Visual indicators for alignment When moving frames in the document, temporary visual indicators are now 

visible, and magnetism can be used to facilitate alignment with other frames. 
Frame alignments The position of two (or more) frames can be horizontally or vertically aligned 

on their borders or their centers. It is also possible to align several frames on 
the center (or borders) of the page. 

Vertical or horizontal frame 
distribution  

The position of three (or more) frames can be distributed to get the same 
horizontal or vertical distance between neighboring frames. 

Properties dialog in multi-selection 
  

The frame properties dialog is now available when selecting several frames. 
In particular, it allows you to change the size of several frames at once. 

Moving frames with directional keys The keyboard directional arrows now move the frame position. Shift+arrow 
moves the position of the zoomed portion in the study, and Ctrl+arrow moves 
the cursor if any. 

 New “Document” and “Illustrations” tabs 
Document tab The Edit tab has been renamed “Document” and reorganized. The Document 

tab displays editing functions related to the format and layout of the current 
document. It also contains export functions. 

New Illustrations tab The illustrations frames, previously included in the Edit tab, are more directly 
accessible in a new “Illustration” tab. Shapes and Arrows illustration settings 
are directly available from ribbon’s buttons. 
The Illustrations tab contains frames useful for commenting on your analysis, or to give 
instructions (text, circle, image etc.), to ensure traceability (date, username, document 
path etc.), to enable navigation (hyperlinks between documents or to a website etc.) 

or to facilitate the use of the document (action button for operator recall, document 
saving etc.).  

View tab The View tab has been reorganized. It displays functions to personalize the 
workspace, define frame positioning and change the Zoom. 

Page viewer panel display The “Page viewer" panel now appears when first opening Mountains or when 
restoring factory settings. 

When updating or reinstalling Mountains, the "Page viewer" panel follows the previous 
user choice as set in the View tab. 

 Product level choice 
Compatibility between document 
and product level 

The software now evaluates compatibility between the current document and 
the products in the range. The user thus benefits from assistance to choose 
the necessary product level when purchasing or upgrading (see below). 

Incompatible document When the current document is not fully compatible with the current product 
level, the user can open the Compatibility dialog from an information strip at 
the top of the document locally. 
This dialog displays the list of product levels (product name and necessary 
modules) authorizing all the functions contained in the current document. 
The user can copy the name of the product levels into the clipboard. 
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Incompatible study or operator When the document contains a feature not available in the current product 
level (study, operator), the user can open the Compatibility dialog from the 
contextual menu of the corresponding line in the Workflow panel. 
In this case, the Compatibility dialog displays the list of product level 
compatible with this particular feature. 

Switch to compatible product Using a Free trial, OEM demo or Loan license, the dialogs allow the user to 
switch to a compatible product. 

Compatibility dialog access Even if the current document is fully compatible, the Compatibility dialog can 
be displayed, from the Help tab, License dialog. 

 Home screens 
Shortcut and Splash screen The Shortcut icon and the Splash screen have been redesigned. 

Home and Learning tabs in the 
Home dialog 

The Home dialog page has been refined and now has two sections for 
greater readability. 
The Learning section allows the user to discover Mountains® using various 
resources. 
The Home section invites the user to start working (new document or 
studiable, recent document or studiable), and to discover new version 
features. 

Blue gradient color theme Mountains® 11 introduces a customized modern "Blue gradient" screen 
theme, set by default. The “Blue gradient” color is a gradient from dark blue 
to lighter blue, with touches of “jungle green”. 

 Other general features 
Operator recall button creation You can rapidly insert a button to recall an operator from the operator line in 

the Workflow panel. 

Vertical text in Screen notes and 
bubbles 

The text can be positioned vertically in the Screen notes and Bubbles 
illustrations. 

Color of tables with results in 
studies 

All tables listing parameters or results in studies now use the same light 
green as in the "Parameters Table" study, for greater consistency. This 
applies to all studies generating results, and to the "Table of results" study. 

Shortcuts to Tolerance limits from 
Table of results 

You can open the Tolerance limits dialog by double-click on the Pass/Fail or 
Tolerance column of the “Table of results” study. If a line or a cell was 
previously selected, the corresponding parameter will be selected in the 
Tolerance limits dialog. 
The corresponding parameters are also directly selected in the ‘Tolerance 
limits’ manager dialog, when you select one or several lines in the “Table of 
results” study, and you click on the [‘Tolerance limits’ manager] button. 

Saving multiple studiables  The saving of several studiables at the same time is now possible from the 
contextual menu on a multi-selection of studiables in the workflow. 

Link to license details from About 
dialog 

A ‘Show license’ dialog box link is displayed in the About dialog, to rapidly 
access more details about the license. 

Default data display in Global 
preferences renamed 

The Loading data / Default SmartFlows preference, and the Data display / 
Default studies preference have been renamed and reorganized for better 
clarity. 

Read only text in the file name [Read only] text is displayed at the top of the software window after the file 
name, if the file has a “Read only” attribute. The information strip at the top 
of the document is no longer displayed. 

[Assemble] ribbon group 
reorganized 

The [Assemble] group of the operator ribbon has been splited into three 
groups: [Assemble], [Add/Delete] and [Create]. 
These groups are or are not, visible depending on the operators available for 
the studiables. 

Loading studiables in all products All studiable types can now be loaded into all products (provided that the file 
format is included in the product). 
 Only the “Identity card” study can be displayed. For some studiable types 
(e.g., surface-image), extraction operators have been added in relevant 
products.  
In the File explorer panel, the icons of all studiable types (of file formats 
included in the product) can be visualized.  

Distinguishing RGB images from 
grayscale images in the name 
 

The distinction between RGB and grayscale images has been added to the 
name of the studiable-type displayed in the workflow, as is done in the 
identity card. 
“Grayscale image” or “RGB image” is displayed when hovering over the icon. 
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Enhanced integration of 
Mountains® from external 
applications 

It is now possible to get a separate Mountains® application window when 
driving Mountains using ActiveX from an external application (it was previously 

only possible to integrate Mountains interface inside the external application window). 

It is also possible to drive several Mountains windows. The applications run 
separately, preventing one application from crashing even if it crashes in 
another window. 
 
The Software Development Kit documentation has been updated (available 

from the Automation tab). 

  
 

Multi-technology features 
 More realism in 3D rendering 
3D rendering engine more realistic All studies and operators using 3D rendering with light effect, now benefit 

from a physically based rendering, resulting in a more realistic display. 
It concerns the “3D view” study on Surface, Series of surface, Surface + image, Image, 
Multi-channel image, Multi-channel cube, Shell, Point of cloud, Hyperspectral image 
and IV spectroscopy image studiables, the “Wear and deposit analysis” study on 

Surface, Series of surfaces, Surface + image and Multi-channel image studiables, and 
the 3D previews in the operators “Single-image reconstruction”, “Stereoscopic 
reconstruction”, “3D reconstruction using three images”, “3D reconstruction using four 

quadrant images”. 

Improved graduation display The graduation texts are sharper and with less overlap. 
Intuitive rotation in 3D renderings The center of the rotation is now the center of the zoomed zone (and not the 

center of the surface) in 3D view renderings. 
 “3D view” study’s ribbon 
Material settings in “3D view” study Roughness and metalness visual aspects can now be defined (using sliders), 

on all renderings using light. 
It replaces the previous Gloss setting. 

Lines on top of rendering in “3D 
view” study 

The lines can now be displayed on top of any rendering (lines, mesh, contour 
lines). 

3D view ribbon reorganization The ribbon of the 3D view studies has been reorganized for more intuitive 
settings. 

Slider for amplification in “3D view” 
study 

A slider can now be used to set the z amplification. 

Modernized icons in “3D view” study Some icons of the “3D view” study have been modernized. 
 X - Y cursor on surfaces and images 
X-Y cursor on surfaces and images A cursor can now be displayed in some studies on Surface, Image and 

comparable studiables. The cursor shows two perpendicular crossed dotted 
lines. The studies with cursor can display X and Y position values (in the 
current coordinate system, relative or absolute) and the Z value if applicable 
(in the current Z scale) of the current surface element in the study’s table. 
In automation context, the X-Y cursor position is defined in absolute 
coordinate values. 
This applies to the “Pseudo-color view” study and to the Summary of the current 
operator on Surface, Series of surfaces, Images, Surface+Image, Multi-channel 
images and Multi-channel cube studiables, to Photo simulation and Contour lines 

studies on Surface studiables, and to the “True color view” study on Image and Series 
of images studiables. The values are not included in the result manager. 

 Stitching operator  
“Stitch” operator redesigned The “Stitch” operator dialog has been completely redesigned for better 

ergonomics, allowing for covering a greater number of cases, and expanded 
automation possibilities (see below). 

Big preview in “Stitch” operator The grid view (showing the position of each studiable in its corresponding 
tile), is displayed in a big preview. The user can switch between the grid view 
and the result preview. 

Semi-automatic method in “Stitch” 
operator 

The manual positioning has been replaced by a semi-automatic setting 
called ‘Use studiable properties’. 
This method uses rules to position the studiables in the grid view, using 
starting position on a corner, filling path, and sorting rule (from studiable 
name, measurement date or studiable number in the workflow). 
It also allows the user to define a global overlap between tiles. 
Manual refinement of the position of a tile is possible, with transparency 
effects and optional magnetism between tiles. 
The completely automatic methods (‘Use XY absolute coordinates’ and ‘Use automatic 
feature detection’) have been renamed but not modified. 
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Easy and automatable selection of 
studiables in “Stitch” operator 

A searching bar can be used in the “Stitch” operator, either to temporarily 
help the user to find and select a compatible studiable, or to define studiable 
selection rules applicable in automation contexts (for example, to select all 
surfaces after micro-roughness filtering, regardless of the number of 
surfaces in the document). The reference studiable is identified in bold text. 

 New “Extract local contour” operator on surface and on 

image 
New “Extract local contour” operator 
on surface and image 

The new “Extract local contour” operator locally detects edges and generates 
a Contour profile from Surface, Surface + image and Image studiables. 
The edge detection method is applied on extracted auxiliary profiles. 

Extraction shapes in “Extract local 
contour” operator on surface and 
image 

The user can select and position different profile extraction shapes (parallel, 
double parallel, and radial). The number of profiles (extraction resolution) 
and optional average width can be defined. 

Edge detection methods in “Extract 
local contour” operator on surface 
and image 

The edge detection applied on the extracted profiles uses either Threshold, 
Derivative, or a Polynomial method. 
The user can choose to detect only rising, only falling edges, both rising and 
falling, or the average. 
For the derivative method, it is possible to set the searching window size, to 
smooth the derivative, and to fine tune the detection sensitivity. 

 Correlation in “Scale sensitive fractal analysis” (SSFA) 
study on Series 

Scale of better correlation between 
T axis and developed length in 
SSFA study on Series 

In the “Scale sensitive fractal analysis” study, it is now possible to evaluate 
the correlation between a variable T along a Series (entered by the user), 
and the developed profile length (or developed surface area) at a defined 
scale. You can display the Regression coefficient R² coefficient along the 
series in function of the scale. The maximum of this graph gives the scale at 
which there is the better linear correlation between developed length (or 
area) and a variable. It allows the user to find at which scale a variable has 
an effect on the surface. The variable can be a value of the fabrication 
process (e.g., polishing speed) or a functional property (e.g., tribological 
behavior). 
This applies to Series of profiles and Series of surface studiables. 

Statistical studies on SSFA study for 
Series 

It is now possible to apply statistical studies (“Control Chart”, “Scatter plot”…) 
on the results of the “Scale sensitive fractal analysis” (SSFA) study on Series 
of profiles and Series of surfaces studiables. 

 Classification in “Fiber analysis” study 
Classification in “Fiber analysis” 
study 

It is now possible to classify the fibers in the “Fiber analysis” study. 
The classification functions are identical to the ones in the “Particle analysis” 
study.  
In particular, you can classify the fibers using parameters values or a combination of 
parameters values, exclude classes from calculation, display color by class and 

legend, calculate statistical parameters by class, and share classifications on other 
documents or with colleagues. The “Fiber analysis” study is available for Image 
studiables (in particular SEM images), and for surface studiable types. 

Histogram display in “Fiber analysis” 
study 

It is now possible to hide the histogram or to change its color in the “Fiber 
analysis” study. 

Dynamic images from “Fiber 
analysis” study 

Dynamic image export is now available for all images produced by the “Fiber 
analysis” study on surfaces or on SEM images. 

 Edge preserving filters 
Edge preserving filters in “Spatial 
filter” operator 

The ‘Bilateral’ filter and the ‘Guided’ filter have been added in the “Spatial 
filter” operator. Those filters reduce noise while preserving the edges. Sliders 
are available to find the best compromise between noise reduction and edge 
preserving.  
This also applies to Image, Series of images, Surface, Surface + image, 
Series of surfaces, Multi-channel image, Multi-channel cube studiables. 

 Cube cutting planes 
XY cutting planes in Multi-channel 
cube 

Cutting plane in X or Y direction can now be displayed in the Pseudo-color 
View on Multi-channel cube studiables (previously only Z was displayed). 

 Adaptation of tools to more studiable types 
Availability of operators or studies 
on Surface + Image 

The “Fit an asphere” operator, and the “Volume parameters“, “Sk 
parameters“ and “Slope distribution” studies are now available for Surface + 
image studiables. 

Availability of operators on Series of 
surfaces 

The “High/Low pass filter”, “Morphological filter“ and “Edit axes” operators 
are now available for Series of surfaces studiables. 
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Availability of operators on Series of 
images 

The “Rotate”, “Enhance the image”, “Homogenize lighting”, ”High/Low-pass 
filter”, “Convert to series of surfaces” and “Convert RGB to monochrome 
image” operators are now available for Series of images studiables. 

Availability of operators on Series of 
profiles 

The “Morphological filter“ operator is now available for Series of profiles 
studiables. 

 Linked studies 

Synchronization between studies It is now possible to link the attributes of several studies of the same 
document (synchronization). It means that if several studies are 
synchronized using a link concerning an attribute, the modification of this 
attribute in one of the studies, modifies this attribute in all other linked studies 
accordingly. See below the attributes that can be linked. 

XY-position synchronization 
 

The position of the X-Y cursors can be linked between studies. 
X-Y cursors positions are defined in absolute coordinate’s values. Error 
cases (for example cursor position outside of the study’s border) are 
managed with informative error messages. 
This applies to the “Pseudo-color view” study and to the “Summary of the current 
operator” study on Surface, Series of surfaces, Images, Surface + Image, Multi-
channel images and Multi-channel cube studiables, to Photo simulation and Contour 

lines studies on Surface studiables, and to “True color view” study on Image and 
Series of images studiables. 

This X-Y position can also be linked with studies on Hyperspectral images 
studiables (and on IV images studiables). It concerns cursor positions in the 
Hyperspectral image view (and IV image view), and displayed curve for the 
other studies (Spectrum curve view, Peak fitting view, Normalized view, Stacked 

view, Strips view). 
Zoom in % (XY) synchronization 
 

The image zoom level (in %) can be linked between studies. 
This applies to all studies with surfacic image visualization (e.g., Pseudo-color 

view on Surface studiables, Grid view on Multi-channel image studiables, Force 
volume view, Hyperspectral image view etc.) 

Zoom in absolute value (XY) 
synchronization 

The image zoom level and position (in metric unit) can be linked between 
studies. This is particularly useful with different visualizations of the same 
sample with common coordinates system. 
This applies to all studies with surfacic image visualization (e.g., Pseudo-color 

view on Surface studiables, Grid view on Multi-channel image studiables, Force 
volume view, Hyperspectral image view etc.) 

Zoom in % (curve) synchronization 
 

The curve zoom level can be linked between studies. 
This applies to all studies on Profile, Series of profiles, Multi-channel profiles, 
Spectrum curve, Series of Force curve and IV curve studiables.  

Element number synchronization  The element number can be linked between studies. 
This applies to all studies with several elements, on Series of Profiles, Series of 

surfaces, Series of images, Multi-channel images, Multi-channel profiles, Series of 
force curves studiables. 

Force curve synchronization 
 

The force curve number can be linked between studies. 
This applies to “Force curve analysis” and “Force volume” studies. 

Force curve segment 
synchronization 

The displayed segment (approach or retract) can be linked between studies. 
This applies to “Force volume view” study. 

Spectrum curve synchronization 
 

The spectrum curve number can be linked between studies. 
This applies to all studies on Hyperspectral image, IV curves and IV spectroscopy 
image studiables. 

Spectrum curve (W) synchronization  The position number on the spectral axis can be linked between studies. 
This applies to Hyperspectral image view and IV image view studies. 

Cutting planes synchronization  The slice numbers of (X, Y and Z) cutting planes on cube can be linked 
between studies. This applies to Pseudo-color view and to 3D view on Multi-channel 

cube studiables. 
Synchronization manager The Synchronization manager dialog allows you to create, modify and delete 

links between studies inside a document. It is available from any study 
containing synchronizable attributes. 

Synchronization management 
shortcuts 

When selecting several studies containing synchronizable attributes, a [Link] 
button directly opens the Synchronization manager dialog with the 
corresponding selected studies. 

Link icon in the study If the selected study is linked to another study in the document, a link icon is 
visible in the top right corner. 

  
 

Profilometry features 
Curve export in the “Slope 
distribution” study 

The slope distribution values can now be exported to a text file from the 
“Slope distribution” study. This applies to Surface and Surface + image studiables. 
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Display of parameters in “Rk (Sk) 
parameters” study 

In the “Rk (Sk) parameters” study, the display of parameters in the table 
below the curve, and the settings dialog, are now identical to the ones of the 
“Parameters table” study. More pre-processing settings are thus available 
(e.g., microroughness), and more information can be displayed (e.g., 
warnings). 
This applies to the “Rk parameters” study on Profiles and Series of profiles studiables 

and to the “Sk parameters” study on Surface, Surface-image, Multi-channel Images 
and Series of surfaces studiables. 

Automatable exclusion zones in the 
“Level” operator on Profile 

Exclusion zones in the “Level” operator on Profile studiables, can now be 
defined in metric units, in relative or in absolute coordinates. Result pickers 
can be used in automation contexts. 

Fine spacing values for the ‘Circular 
analysis’ in Contour study 

The ‘Circular analysis’ tool on a portion of a closed Profile studiable now 
accepts values with a precision of 0.1 degree. 

Frequency index in “Frequency 
spectrum” study on Profile 

The frequency index is now a separated cursor parameter in the “Frequency 
spectrum” study on Profile studiables. 

Homogenization in the “Level” and 
“Retouch points” operators on 
Profile 

The interface for units’ choice has been homogenized with “Extract profiles” 
operator in the “Level” and “Retouch points” operators on Profile and Series 
of profiles studiables (%, points, metric unit, and metric unit in absolute 
values). 

Homogenization of operator dialogs A few last operators have been redesigned to conform to the operators 
dialogue interface guide. 
Profile or Series of profiles: “Extract area", "Convert to sliding profiles", "Concatenate 
two profile", “S-filter”. Series of surfaces: “Extract transversal profile”, “Filter using 

PCA”. 
 Shell and Point cloud features 
New operator “Stitch together in 3D 
space” 

The “Stitch together in 3D space” operator now allows you to automatically 
assemble Surface (and Surface + image) studiables with Point cloud 
studiables, using recognizable points in the overlapping zone. 

Automatic fit with partial Shell in 
“CAD compare” study 
 

The pre-fit function is now compatible with a partial Shell in the “CAD 
compare” study on Shell. This allows the user to compare a partial shell 
(actual data (e.g., measured shell)) with the CAD model (nominal model) that 
represents the entire work piece. It is an alternative to the manual mode, which is 

slower and requires the user to locate the right critical points. 
New “Fill holes” operator on Shell The new "Fill holes" operator on Shell studiables reconstructs the missing 

parts of a mesh. 
Two filling options are available: One for covering relatively flat areas 
(Relatively planar holes) and the other for areas with curvature (Highly 
curved holes). It is possible to fill only holes that are smaller than a particular 
area. 

Simplification of the “Mesh the point 
cloud” operator 

The dialog box of the “Mesh the point cloud” operator has been simplified 
and optimized: several settings previously available are now automatically 
calculated from the Cloud geometry. Calculation is now faster. 

Export Point cloud to PLY It is now possible to export a point cloud in PLY format. 

  

 

Spectroscopy features (for Spectroscopists or 
SPM users) 

Exponential fit in “Peak fitting 
analysis” study on spectra 
 

‘Single exponential’, ‘Stretched exponential’, ‘Double exponential’ curve and 
‘Logarithmic’ curve fitting are now available in the “Peak fitting analysis” 
study on spectra. In particular, it can be used to study time decay when the 
W axis represents time. It applies to Spectrum curve and Hyperspectral image 

studiables. 
Cursor coordinates in hyperspectral 
images and IV spectroscopy images 

All studies on Hyperspectral images studiables now display homogenized 
XY cursor coordinates. Coordinates of the cursor can be displayed in 
absolute coordinate, and in points. The current signal name can also be 
displayed. It also applies to all the studies on IV spectroscopy image 
studiables. 

Position of extracted line of spectra The curve position in Spectrum curve studiable, after the extraction of a line 
of spectra in the “Extract series of spectrum curve” operator is now stored as 
a T axis value and renamed Position of the spectrum curve. It starts from 0 
(it previously was coordinates on the source “Hyperspectral image view” study). 
This also applies to IV curve studiables. 

Proportion kept in “Hyperspectral 
image view” study 
 

The proportion of the spectra and the image sizes are now kept when 
resizing the “Hyperspectral image view” study. The proportion is also kept in 
full screen mode. 

“Use spectral bands” operator on IV 
spectroscopy image 

The “Use spectral bands” operator has been adapted to IV spectroscopy 
image studiables (it was already available on Hyperspectral image studiables). It 
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can create  colorized maps using user-defined color assigned to values 
(Area, FWHM, Max, Max amplitude, Max position) calculated on bands in the 
W axis. 

  

 

New Mountains® Products 
New  MountainsSPIP ® 
Nanospectral Starter and Expert 
products 

The MountainsSPIP® range is extended with the addition of the 
MountainsSPIP® Nanospectral Starter and MountainsSPIP® Nanospectral. 
This is destined for users working on both SPM and Spectral technologies 
(e.g., nano-IR and TERS). 
This completes the MountainsSPIP® products: MountainsSPIP® Starter, 

MountainsSPIP®  Expert, MountainsSPIP® Academy and MountainsSPIP® Premium. 

New MountainsSEM® Image 
Analysis product 

The MountainsSEM® Image range is extended with the addition of the 
MountainsSEM® Image Analysis product. It is specifically aimed at users 
performing 2D SEM image analysis, and offers features such as semi-
automatic object colorization, particle analysis and correlative analysis with 
EDS maps. 
This completes the MountainsSEM® range: MountainsSEM® color, MountainsSEM® 
Expert and MountainsSEM® Premium. 

Four-quadrant reconstruction 
improvement  

The reconstruction of topography from the 4 images of a 4-quadrants BSD 
detector has been improved. In particular, it gives better results on 
geometrical features. Previous methods are kept for compatibility. 

  

 

Updates and translations for Interface & 
Reference Guide 

  
User interface New texts related to new features have been added to the user interface (in 

English). They have been translated into all available languages: French, 
German, Italian, Spanish, Japanese, Chinese, Polish, Korean, Brazilian 
Portuguese, Russian. 
Note: A complete retranslation into Japanese is in progress. This means that the style 

and vocabulary might not be homogeneous for the moment.  

Reference Guide The Reference Guide has been updated with the descriptions of most new 
main features and improvements (in English). It has been translated into all 
available languages (French, German, and Japanese). 
Note: A complete retranslation into Japanese is in progress. This means that the style 

and vocabulary might not be homogeneous for the moment. You might find some 
English sentences (in the Japanese Reference Guide). 

 

 

 

 

Bug corrections (A and B type) 

 Type 

 

Bug Description 
 

MNT- 

10391 
A 

The software may crash if you filter the tree structure of a composite (Surface+image, 
Multi-channel image etc.) studiable by name in the studiable explorer panel. 

MNT- 

10835 
A 

The Ssw parameter (dominant wavelength) calculation on surface studiables according 
to ISO 25178 can be incorrect on surfaces having little or no dominant wavelength. 

MNT- 

11045 
A 

The sofware may crash when opening the “3D reconstruction using three images” 
operator on Image studiables. 

MNT- 

11127 
A 

A crash can occur when opening the “Apply mask of non-measured points” operator on 
Surface, Surface + image, Multi-channel image studiables. 

MNT- 

11402 
A 

Values in the “Table of results” study may be missing or incorrect in the result of the "Fit 
an asphere" operator on Surface and Profile studiables. 

MNT- 

11507 
A 

The 3D view of the generated Shell studiable is no longer displayed in the “CAD compare 
study” when reloading older v10 documents. 
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MNT- 

4171 
B 

Changing the rendering mode to multi-selection on different studiable types in the “3D 
view” study may result in invalid rendering in one of the selected studiables. 

MNT- 

8355 
B 

The flat area is not respected when applying the “3D reconstruction using four quadrant 
images” operator on Image studiables in certain particular cases. 

MNT- 

10520 
B 

The parameters of the “Sk parameters”, “Rk parameters” and “Parameters table” studies 
on Surface and Profile studiables are not calculated when using an ‘F-Operator’ of type 
‘Absolute Total least squares sphere (Absolute TLSSP)' or ‘Total least squares circle 
(TLSCI)'. 

MNT- 

10730 
B 

The “Add/remove image” operator on Series of images studiables does not display the 
studiables in the Available studiables section of the dialog box if the loaded data is very 
large. 

MNT- 

10807 
B 

It is not possible to move between pages in a document by scrolling with the mouse 
wheel or using the scroll bar with the mouse if the [Page by Page] button is activated. 

MNT- 

10886 
B 

Modifying the channel colors of a Multi-channel image studiable that is not a root 
studiable does not result in the colors being modified on the root studiable. 

MNT- 

11021 
B 

Zooming using a rectangular shape in a “Grid view” study on Series of surfaces 
studiables does not display the correct view of the surfaces. 

MNT- 

11036 
B 

The results from the “Result manager” of a document containing a “Result calculator” are 
incorrect when the document is reloaded. 

MNT- 

11046 
B 

The software may crash when adding a "Resample" operator before a "Scale the image" 
operator on Image studiables in the workflow in a particular case. 

MNT- 

11065 
B 

Statistical studies on Surface, Surface + image, Image and Multi-channel image 
studiables, using a class from a "Particle analysis" study as a filter, become empty if a 
class is renamed in the ‘Classification’ dialog box of one of the studies in the statistical 
analysis. 

MNT- 

11088 
B 

Results filtered in the Result manager may be incorrectly exported, as the filter can be 
incorrectly applied, particularly in an automated environment. 

MNT- 

11089 
B Loading a Shell studiable in STL format does not work. 

MNT- 

11097 
B 

Operator dialog boxes can be hidden if the user previously had 2 screens and only one 
is currently available. 

MNT- 

11112 
B 

Duplication of an “Advanced contour analysis” study (Ctrl+D) on Profile or Contour profile 
studiables does not always work properly. 

MNT- 

11130 
B 

The W-axis unit is incorrect if the Apply Jacobian intensity correction option is selected 
in the “Convert W-axis” operator on Spectrum curve studiables. 

MNT- 

11132 
B 

The base line height is incorrect when selecting the Average the curve option in the 
“Extract series of spectrum curves” operator dialog box on Hyperspectral image 
studiables. 

MNT- 

11138 
B All channels of studiables in ZMG format are not always loaded. 

MNT- 

11142 
B 

Opening the ‘Peak fitting properties’ dialog box in the “Peak fitting” study on 
‘Hyperspectral image studiables can affect which curve is displayed. 

MNT- 

11146 
B 

The ‘Peak fitting properties’ dialog box in the “Peak fitting” study on Hyperspectral image 
studiables does not always display properties if the Hyperspectral image studiable 
contains non-measured points. 

MNT- 

11149 
B 

Mountains® may use commas when dealing with real values instead of dots, depending 
on the regional settings of the host application, when running the software from a third-
party application. 

MNT- 

11261 
B 

The V-groove analysis tool in the “Advanced contour analysis” study does not work if any 
tolerance is set when it is created. 

MNT- 

11299 
B F-operators are not applied on studiables used for calculations of addon parameters. 

MNT- 

11302 
B 

It is not possible to modify the palette of the 3D Result view in the "Map local properties” 
operator on Series of surfaces studiables. 

MNT- 

11309 
B 

It is not possible to export the Abbott curve data to a text file in the “Sk parameter” and 
“Rk parameters” studies using the [Export curve] button. 
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MNT- 

11318 
B 

The settings in the Special options dialog of the” Scale sensitive fractal analysis” study 
on Surface, Series of surfaces and Image studiables are not taken into account in the 
management of the study settings. 

MNT- 

11328 
B 

The export of the numerical results to a text file in CSV format when applying a template 
or when using a command file is erroneous if a semi-colon is used in the results. 

MNT- 

11334 
B 

The 'Calculate line width roughness' tools do not work when the selected segments are 
parallels in the “Advanced contour analysis “study. 

MNT- 

11392 
B 

Inserting a "Result calculator” into a document does not generate an error message when 
being used in a product that does not contain this function. Affects demo and free trial 
licenses only. 

MNT- 

11399 
B 

Some translations for form removal ("F-operation") are missing from the “Parameters 
table” dialog box on profile studiables. 

MNT- 

11400 
B 

Some advanced calibration options are not translated in the “3d reconstruction using four 
quadrant images” operator on Image studiables. 

MNT- 

14111 
B The points are reversed in Y in the "3D view" study on Multi-channel cube studiables. 

MNT- 

11452 
B 

The ‘S-filter (λs)’ filter is not applied on Profile or Surface studiables used by addons 
parameters even when requested. 

MNT- 

11471 
B 

The channels are not correctly displayed when applying the “Threshold” operator on a 
Multi-channel image studiable if some channels are flat. 

MNT- 

11472 
B 

The histogram of heights is not correctly displayed in the color scale on Multi-channel 
image studiable if some channels are flat. 

MNT- 

11506 
B 

The pre-alignment of the Shell studiable in the "CAD compare" study is not preserved 
when the study is copied and pasted or when the document is saved and then reloaded. 

MNT- 

11512 
B 

The generated Shell studiable is not redisplayed in the "CAD Compare" study when 
undoing a previous selection of the [Generate Shell and Deviations] button in the study. 


